BAB Il
ANALISIS DAN PERANCANGAN

I11.1. Analisis Sistem yang Berjalan

Proses yang sedang berjalan dalam penginformasian Lokasi Perumahan Di
Medan Marelan ini masih bersifat manual. Bentuk manual yang dibuat oleh dinas
terkait yaitu dengan bertanya kepada orang dan pihak deplover membuat brosur.
Banyaknya kendala yang terdapat pada penginformasian melalui telepon,
mengakibatkan Perumahan Di Medan Marelan kurang diketahui masyarakat luas.

Melihat kebutuhan akan informasi tentang Lokasi Perumahan Di Medan
Marelan merupakan hal yang penting bagi setiap masyarakat yang ingin
mengetahui alamat, lokasi dan fasilitas yang ada pada Perumahan yang akan di
promosikan di Medan Marelan. Namun kesulitan umum yang sering dialami oleh
mayarakat adalah tidak terdapat informasi yang cukup dan tidak mengetahui
alamat dan lokasi Perumahan yang ada di Medan Marelan tersebut. Dalam
aplikasi yang dibuat ini akan membantu masyarakat dalam mendapatkan
informasi Alamat dan Lokasi Perumahan di Medan Marelan yang ingin diketahui.
Menyajikan sebuah peta yang dapat berinteraksi dengan penggunanya sehingga
dapat memberikan informasi yang lebih akurat. Adapun analisis sistem ini

meliputi input, proses dan output yang dijabarkan sebagai berikut :

111.1.1. Analisis Input
Analisis sistem input yang sedang berjalan pada sistem yang lama adalah

data perusahaan provider, data alamat perumahan, type perumahan, harga
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perumahan yang akan dipasarkan dalam bentuk brosur yang akan disebarkan

kepada masyarakat.

111.1.2. Analisis Process\

Proses yang terjadi pada sistem yang dijelaskan pada langkah-langkah:

Sistem Informasi Geografis Lokasi Perumahan Medan
Marelan

Perumahan Medan Masyarakat
Marelan

(
y

Iklan / Brosur
_ | Perumahan Medan
> Marelan

Iklan / Brosur
Perumahan Medan
Marelan

BN

Mengingat
Alamat
A 4
Mengunjungi Mengunjungi
Perumahan [ Perumahan
Medan Medan
Marelan Marelan

\ 4

\/ SELESAI

Gambar I11.1. Flow Of Document Lokasi Perumahan Marelan

Phase
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Penjelasan FOD :

1. Masyarakat mendapatkan informasi mengenai lokasi perumahan yang berada
di kota Medan khususnya di daerah marelan melalui iklan dan selebaran
brosur.

2. Kemudian Masyarakat mengingat atau mencatat alamat lokasi lokasi
perumahan tersebut.

3. Setelah mendapatkan informasi Lokasi perumahan, Masyarakat melakukan

pengunjungan ke lokasi Lokasi perumahan yang mereka ketahui.

111.1.3. Analisis Output

Output yang dihasilkan dari sistem adalah informasi-informasi tempat
Lokasi perumahan yang ada di kota Medan khususnya di daerah marelan dan
mengunjungi Lokasi perumahan yang di inginkan maka Masyarakat akan
mendapatkan jasa pelayanan sesuai dengan kebutuhan Masyarakat yang diberikan

oleh pihak Lokasi perumahan yang bersangkutan.

I11.2. Evaluasi Sistem yang Berjalan
Sistem vyang sedang berjalan memiliki beberapa kelemahan yang
dijabarkan sebagai berikut:
1. Lambatnya memberikan informasi lokasi Perumahan yang ada di Medan
Marelan.
2. Bagaimana mencari lokasi Perumahan yang ada di Medan Marelan secara
cepat dan mudah.

3. Sulitnya masyarakat mencari lokasi Perumahan di Medan Marelan dengan
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tepat waktu langsung datang lokasi untuk mengetahui lokasi Perumahan yang
ada di Medan Marelan.
Sistem yang sedang berjalan memiliki beberapa kelebihan yang dijabarkan
sebagai berikut:
1. Informasi dapat di akses oleh semua kalangan masyarakat.
2. Informasi lebih jelas karena berbentuk brosur mengenai fasilitas-fasilitas
perumahan.

3. Sistem dapat diterima dengan baik oleh masyarakat.

I111.3. Desain Sistem

Berdasarkan hasil analisa sistem pada penelitian ini dibagi menjadi dua
desain, yaitu desain sistem secara global untuk penggambaran model sistem
secara garis besar dan desain sistem secara detail.
111.3.1.Desain Sistem Secara Global

Desain sistem secara global menggunakan bahasa pemodelan UML yang
terdiri dari Usecase Diagram, Class Diagram, Activity Diagram dan Sequence
Diagram.
111.3.1.1. Usecase Diagram

Secara garis besar, bisnis proses sistem yang akan dirancang digambarkan

dengan usecase diagram yang terdapat pada Gambar 111.1 :
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Sistem Informasi Geografis Lokasi Perumahan Medan

Marelan

<extends>

Data Konten T

Data Perumahan k-<extends>-(Upload Gambar
<extends>

Upload
Thumbnail

<include>

<include>
../ Peta Perumahan
Medan Marelan

User

Blog

Admin

Panduan
Aplikasi Peta

Gambar I11.2. Use Case Diagram Sistem Geografis Lokasi Perumahan
Medan Marelan

111.3.1.2. Activity Diagram
Bisnis proses yang telah digambarkan pada use case diagram di atas
dijabarkan dengan activity diagram :
1. Activity Diagram Melihat Peta
Aktivitas melihat peta diterangkan dalam langkah-langkah state, dimulai dari
kegiatan melihat panel peta kemudian mencari Artikel Lokasi perumahan,
selanjutnya menekan tombol atau link yang ada pada peta dan yang terakhir

melihat informasi yang di sajikan dalam peta yang ditunjukkan pada gambar 111.3:



53

®
J

Halaman Utama

< Click Peta Perumahan >

Click Salah Satu marka Perumahan

(Melihat Informasi Lokasi Perumahan>

O

Gambar 111.3. Activity Diagram Melihat Peta

2. Activity Diagram Login Administrator Website

Aktvitas proses login admin diterangkan dalam langkah-langkah state,
dimulai dari memasukkan username, memasukkan password, jika profil valid
maka sistem akan mengaktifkan menu administrator, sedangkan jika tidak valid,

maka tampilkan pesan kesalahan yang ditunjukkan pada gambar I11.4:

®

[ Memasukkan Username

L

[ Memasukkan Password j

i valid invalid i

{Aktifkan Menu Administratorj ( Menampilkan Pesan Error ]

0

Gambar I11.4. Activity Diagram Login Admin

3. Activity Diagram Mengolah Data Lokasi perumahan
Aktivitas proses mengolah data Lokasi perumahan diterangkan dalam

langkah-langkah state yang ditunjukkan pada gambar I11.5:
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¢

(Memilih aksi pada form data residence>
1

Penc\[rian Tambah Ediit HBEUS
C Memilih Pencarian ) C Mengisi Data ) C Memilih Data ) ( Memilih Data )
Mengetik Kata Kunci Menyimpan Data Mengubah Data Konfirmasi
g yimp g Penghapusan

C Menekan Enter ) Menzﬁ;np:smbol) CMenyimpan Data) C Menghapus Data \/ Ya

Tidak

(@Y

Gambar I11.5. Activity Diagram Mengolah Data Lokasi perumahan
4. Activity Diagram Mengolah Data Buku Tamu
Aktvitas proses mengolah data Buku Tamu diterangkan dalam langkah-

langkah state yang ditunjukkan pada gambar 111.6:

s

C Memilih aksi pada form Buku Tamu \,

X

Tambah Hapus

C Mengisi Data D C Memilih Data D
\L \|/ _ Tidak
C K D C Konfirmasi )
Menyimpan Data
Penghapusan

\L Ya
M k T bol
enekan 1ombo D C Menghapus Data 1

Kirim

@

Gambar I11.6. Activity Diagram Mengolah Data Buku Tamu
5. Activity Diagram Mengolah Data Blog
Aktvitas proses mengolah data Blog diterangkan dalam langkah-langkah state

yang ditunjukkan pada gambar 111.7:
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*

C Memilih aksi pada form Blog }
L

Pencaran Ta mb h Ed Ha P

( Memilih Pencarian ) ( Meng|5| Data J ( Memilih Data ) C Memilih Data )

. . . Konfirmasi
(Mengetlk Kata Kunm) C Menyimpan Data ) C Mengubah Data ) C Penghapusan
( Menekan Enter ) Menelfan Tombo') C Menyimpan Data) ( Menghapus Data Da

Simpan

Tidak

(@

Gambar 111.7 Activity Diagram Mengolah Data Blog

6. Activity Diagram Mengolah Upload Gambar
Aktvitas proses mengolah data upload gambar diterangkan dalam langkah-
langkah state yang ditunjukkan pada gambar 111.8:

¢

G\/Iemilih aksi pada form upload gamban,

Upload Download Har‘lus
Chose File > C Memilih data > C Memilih Data
Tidak
KonflrmaS|
Memilih gambar
Penghapusan
Ya
Menekan Tombol Menekan Tombol
Menghapus Data
upload download

®

Gambar 111.8. Activity Diagram Mengolah Data Upload Gambar



7. Activity Diagram Mengolah Upload Thumbnail

Aktvitas proses mengolah data upload thumbnail diterangkan dalam langkah-

langkah state yang ditunjukkan pada gambar 111.9:

thumbnail

—

Upload Download Hapus

C Memilih aksi pada form upload \/

Chose File > C Memilih data > C Memilih Data >
K f Tidak
CMemlllh thumbnall> onfirmasi
Penghapusan
Ya
CMenekan Tombol> Menekan Tombol C o
upload download ghap )(—

®
Gambar 111.9. Activity Diagram Mengolah Data Upload Thumbnail

111.3.1.3. Class Diagram

Rancangan kelas-kelas yang akan digunakan pada sistem yang akan dirancang

dapat dilihat pada gambar 111.10 :



user

Id_User
Username
Password
Nama

komentar

Kode_Komentar

S7

thumbnail

id
name
type
size
content

T

using

konten

Kode_Konten
Tanggal
Terbit

Judul

Isi
Thumbnail
Tag

Gambar 111.10. Class Diagram Sistem Informasi GIS Lokasi Perumahan

using:

using—p>

ing

Rangka_Atap
Penutup_Atap
Kusen_Pintu_Jendela
Air

Listrik
Luas_Bangunan
Luas_Tanah
Harga

DP_KPR
Bank_KPR
Cicilan

111.3.1.4. Sequence Diagram

Nama
Email
Tanggal -
Pesan jalan
Kode_Jalan
Nama_lJalan
Tipe_Jalan
Lon
Lat
using
using’
gambar
v id
Connection <€—using name
type
ConnectionManager() size
¢ * Q content
using T
spesifikasi using using
Kode Residence
P?nc!a5| residence
Dinding
Lantai Kode Tempat
Plafond Nama_Residence

Alamat

| Telepon

Gambar
Lon

Lat
Keterangan

Rangkaian kegiatan pada setiap terjadi event sistem digambarkan pada

sequence diagram berikut:
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1. Sequence Diagram pada Form Peta
Serangkaian kegiatan saat terjadi event pada form peta dapat dilihat pada

gambar I111.11 :

r FO FO

User Main form Form Peta

Menu ()
click form Peta (

Tampilkan
Menu ()

database ()

\
\
\
\
\
\
:] Koneksi
\

Gambar I11.11. Sequence Diagram Form Peta
2. Sequence Diagram pada Form Login
Serangkaian kegiatan saat terjadi event pada form login dapat dilihat pada

gambar 111.12 :

T O O O O

Administrator Main form Form Login Proses Login Halaman
Web5|te Administrator

\
Tampilkan Fom () D ‘ ‘
\ \
\ \
Menu () ‘ [
| validasinama |
click form login dan password V] D
\ \
\ \
\ \
‘ | Invalid ()
\ {
| | Login sukses ()
\ \
\ \
\ \
\ \
\ \
\

o

Gambar 111.12. Sequence Dlagram Form Login
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3. Sequence Diagram pada Form Data Perumahan
Serangkaian kegiatan saat terjadi event pada form perumahan dapat dilihat

pada gambar 111.13 :

t FO O O

Administrator
Website

Main form Form Data Perumahan Proses

\

\

D \

\

Menu () ‘

click form ‘
Perumahan () D D

)

[ update data (

Tampilkan Fom ()
———————

Koneksi
database ()

Koneksi
database ()

Close form ()

! ! !
Gambar 111.13 Sequence Diagram Form Perumahan

4. Sequence Diagram pada Form Data Spesifikasi
Serangkaian kegiatan saat terjadi event pada form spesifikasi dapat dilihat

pada gambar 111.14 :



1 O

Administrator

O O

Main form Form Data Spesifikasi Proses

Website

———

Tampilkan Fom ()

\ \

\ \

D \ \
\ \

Menu () ‘ ‘

click form [ ‘

Perumahan () D D
\ )

update data (

Koneksi
database ()

Koneksi
database ()
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Gambar 111.14 Sequence Diagram Form Spesifikasi
5. Sequence Diagram pada Form Data Konten
Serangkaian kegiatan saat terjadi event pada form data konten dapat dilihat

pada gambar 111.15 :

T O KO O

Administrator Form Blog Proses
Website

Main form

Tampilkan Fom ()

[
\
[ |
Menu () |
click form |
Blog () D
update data ()

I Koneksi

| database ()
\ \

\

\

\
deletel data ()
Koneksi
database ()

S

Close form ()

|

[
\
\ \ \
\ \ \
\ \ \
] | | |
Gambar 111.15. Sequence Diagram Form Data Konten

6. Sequence Diagram pada Form Data Buku Tamu
Serangkaian kegiatan saat terjadi event pada form buku tamu dapat dilihat

pada gambar 111.16 :



61

O O O

Administrator
Website

Main form Form Data Buku Tamu Proses

Tampilkan Fom ()
|

Menu ()

o

click form
Buku Tamu ()

O—————=

N

| update data (
Koneksi
| database ()
I
\ | deleteldata() _|
| Koneksi
‘ database ()

Close form ()

Ty

\

\
\ \
\ \
\ \
i \ \ \
Gambar 111.16. Sequence Diagram Form Buku Tamu

7. Sequence Diagram pada Form Upload Gambar
Serangkaian kegiatan saat terjadi event pada form upload gambar dapat dilihat

pada gambar 111.17 :

: FO O O

Administrator Main form Form Upload Gambar Proses
Website

D \ \
Tampilkan Fom () |
\

[

Menu () ‘

\ \

click form

I
I
|
I
|
Upload Gambar |, D

upload data ()
Koneksi
database ()

\
\
\
| Koneksi
\
\
\
\

database ()

Koneksi
database ()

Close form ()

Gambar 111.17. Sequence Diagram Form Upload Gambar

8. Sequence Diagram pada Form Upload Thumbnail
Serangkaian kegiatan saat terjadi event pada form upload thumbnail dapat

dilihat pada gambar 111.18 :
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r FO O O

Administrator Main form  Form Upload Thumbnail Proses

Website
m:] Menu ()
click form

\
\
\
\
\
\
Fpload Thumbnail )D D
) |

| upload data (

Tampilkan Fom ()
e —

Koneksi
database ()

\
‘
\ D: E
‘ download data (
Koneksi
‘ database ()
‘ deletel data ()
\
\

Koneksi
database ()

Close form () [

h \
\

\

Gambar 111.18. Sequence Diagram Form Upload Thumbnail

111.3.2. Desain Sistem Secara Detail

Tahap perancangan berikutnya yaitu desain sistem secara detail yang meliputi
desain output sistem, desain input sistem, dan desain database.
111.3.2.1. Desain Output

Berikut ini adalah rancangan tampilan desain peta yang akan dihasilkan oleh

sistem:
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GIS RESIDENCE

Beranda Buku Tamu Blog Peta Perumahan/Residence Panduan Aplikasi Peta Administrator

Peta Sistem Informasi Geografis Perumahan

Klik salah satu nama lokasi vang tertera pada menu di sebelah kiri, kemudian klik marka peta untuk melihat informasi lokasi vang tersedia.

Untuk mencari tempat, anda dapat menggunakan form pencarian dibawah peta.

Tampilan Peta

| [E=a

Nama Residence

Gambar 111.19. Desain Tampilan Peta

111.3.2.2. Desain Input
Berikut ini adalah rancangan atau desain input sebagai antarmuka pengguna:
1. Desain Form Login

Desain form login dapat dilihat pada gambar 111.20 :

GIS RESIDENCE

Beranda Buku Tamu Blog Peta Perumahan/Residence Panduan Aplikasi Peta Administrator

Login Admin

Username ‘ ‘

Password ‘ ‘

Gambar 111.20. Desain Form Login
2. Desain Form Data Lokasi perumahan

Desain form Data Lokasi perumahan dapat dilihat pada gambar 111.21 :



GIS RESIDENCE

Beranda Data Residence Data Spesifikasi Data Konten Upload Gambar | Upload Thumbnail | Data Buku Tamu

Form Residence

Nama Residence

Alamat

|

Keterangan

Telepon |Gambar

Pilih Gambar hd |

Lokasi Pada Peta ‘ | : ‘ | Peta

‘ Nama Residence " ‘

|

Keluar

Gambar 111.21. Desain Form Lokasi perumahan

3. Desain Form Data Spesifikasi

Desain form Data spesifikasi dapat dilihat pada gambar 111.22 :

GIS RESIDENCE

Beranda Data Residence Data Spesifikasi Data Konten Upload Gambar | Upload Thumbnail| Data Bulu Tamu

Form Input Data Spesifikasi

Residence Pilih Residence |z| Air

Pondasi Listrik
el

Dinding Luas Bangunan
&

Lantai Luas Tanah
P

Plafend Harga
2

Rangka Atap DP KPR
4

Fenutup Atap Bank KPR
e

kusen/Pintuflendela Cicilan

Nama Residence V‘ ‘

|

Keluar

Gambar 111.22. Desain Form Spesifikasi
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4. Desain Form Data Konten

Desain form Data Konten dapat dilihat pada gambar 111.23 :

GIS RESIDENCE

Beranda Data Residence Data Spesifilasi  Data Konten Upload Gambar | Upload Thumbnail | Data Buku Tamu

Pengolahan Blog Website

Judul

Diterbitkan

Pilih  w | Gambar | Pilih Thumbnail hd
o <|| =

Keluar

Gambar 111.23 Desain Form Data Konten

5. Desain Form Data Pangkalan Buku Tamu

Desain form Data Pangkalan Buku Tamu dapat dilihat pada gambar 111.24 :

GIS RESIDENCE

Beranda Data Residence Data Spesifikasi Data Konten  Upload Gambar | [Jpload Thumbnail | Data Buku Tamu

Kirim Komentar Kepada Kami

Nama Anda ‘

Email ‘

Komentar

Keluar

Gambar 111.24 Desain Form Buku Tamu
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6. Desain Form Data Upload Gambar

Desain form Data upload gambar dapat dilihat pada gambar 111.25 :

GIS RESIDENCE

Beranda Data Residence Data Spesifikasi Data Konten Upload Gambar|  Upload Thumbnail | Data Buku Tamu Keluar

Pilih Lokasi Gambar
‘ Chaose File | No fils chosen ‘

Daftar Gambar GIS-Residence

Perumahan+Anugra+Marelan++Permai+ jpg Download Delete
Perumahan+Citra++Anugrah jpg Download Delete
Download Delete

Perumahan+Dena-Asri-Residence jpg

Gambar 111.25 Desain Form Data Upload Gambar

7. Desain Form Data Upload Thumbnail

Desain form Data upload thumbnail dapat dilihat pada gambar 111.26 :

GIS RESIDENCE

Beranda | Data Residence Data Spesifikasi | Data Konten Upload Gambar |  Upload Thumbnail| Data Bulu Tamu Keluar

Pilih Lokasi Gambar
| Choose File | No filz chosen ‘ Upload

Daftar Gambar Untuk Blog

kdat-memilih-rumah jpg Download Delete
kpr jpg Download Delete
Download Delete

permintaan-rumah-naik jpg

Gambar 111.26. Desain Form Data Upload Thumbnail

111.3.2.3. Desain Basis Data

Desain basis data terdiri dari tahap merancang kamus data, melakukan
normalisasi tabel, merancang struktur tabel, dan membangun Entity Relationship
Diagram (ERD).
111.3.2.3.1. Kamus Data

Kamus data merupakan sebuah daftar yang terorganisasi dari elemen data

yang berhubungan dengan sistem, dengan definisi yang tepat dan teliti sehingga
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pemakai dan analis sistem akan memiliki pemahaman yang umum mengenai

input, output, dan komponen penyimpan. Kamus data penyimpanan sistem yang

akan dirancang dapat dilihat pada tabel 111.1 :

Data | Atribut Ekspresi Reguler Data

Gambar = | @id + name + type + size + content
1. |Id = | {*"[-+]?[0-9]}
2. | Name = | {[0-9][a-Z][A-Z][Spasi]}
3. | Type = | {[0-9][a-z][A-Z][Spasi]}
4. | Size = | {*"[-+]?[0-9]}
5. | Content = | {[0-9][a-z][A-Z][Spasi]}

jalan = | @Kode_Jalan + Nama_Jalan + Tipe Jalan + Lon + Lat

1. | Kode Jalan = | {"[-+]?[0-9]}
2. | Nama_Jalan = | {[0-9][a-z][A-Z][Spasi]}
3. | Tipe Jalan = | {[0-9][a-Z][A-Z][Spasi]}
4. | Lon = | N[-+]?[0-9]*\.?[0-9]+$
5 | Lat = | N[-+]?[0-9]*\.7[0-9]+$

komentar = | @Kode_Komentar + Nama + Email + Tanggal + Pesan
1. | Kode Komentar = | {"[-+]?[0-9]}
2. | Nama = | {[0-9][a-z][A-Z][Spasi]}
3. | Email = | {[0-9][a-z][A-Z][Spasi]}
4. | Tanggal = | {"[-+]?[0-9]}
5. | Pesan = | {[0-9][a-z][A-Z][Spasi]}

konten = | @Kode_Konten + Tanggal + Terbit + Judul + Isi +
Thumbnail

1. | Kode Konten = | {"[-+]?[0-9]}
2. | Tanggal = | {*"[-+]?[0-9]}
3. | Terbit = | {[0-9][a-z][A-Z][Spasi]}
4. | Judul = | {[0-9][a-Z][A-Z][Spasi]}
5 | Isi = | {[0-9][a-z][A-Z][Spasi]}
6. | Thumbnail = | {[0-9][a-Z][A-Z][Spasi]}

residence = | @Kode_Tempat + Nama_Residence + Alamat +

Telepon + Gambar + Lon + Lat

1. | Kode_Pangkalan = | {*"[-+]?[0-9]}
2. | Nama_Pangkalan = | {[0-9][a-Z][A-Z][Spasi]}
3. | Alamat = | {[0-9][a-Z][A-Z][Spasi]}
4. | Telepon = | {[0-9][a-z][A-Z][Spasi]}
5. | Gambar = | {[0-9][a-z][A-Z][Spasi]}
6. |Lon = | N[-+]?[0-9]*\.?[0-9]+$
7. | Lat = | N[-+]?[0-9]*\.?[0-9]+$
8. | Keterangan = | {[0-9][a-z][A-Z][Spasi]}

spesifikasi = | @Kode_Residence + Pondasi + Dinding + Lantai +

Plafond + Rangka Atap + Penutup_Atap+
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Kusen_Pintu_Jendela + Air + Listrik + Luas_Bangunan
+ Luas_Tanah + Harga + DP_KPR + Bank_KPR +
Cicilan

1. | Kode_ Residence = | {"[-+]?[0-9]}

2. | Pondasi = | {[0-9][a-Z][A-Z][Spasi]}
3. | Dinding = | {[0-9][a-Z][A-Z][Spasi]}
4. | Lantai = | {[0-9][a-z][A-Z][Spasi]}
5. | Plafond = | {[0-9][a-Z][A-Z][Spasi]}
6. | Rangka Atap = | {[0-9][a-z][A-Z][Spasi]}
7. | Penutup_Atap = | {[0-9][a-Z][A-Z][Spasi]}
8. | Kusen_Pintu_Jendela | = | {[0-9][a-z][A-Z][Spasi]}
9. | Air = | {[0-9][a-z][A-Z][Spasi]}
10. | Listrik = | {[0-9][a-Z][A-Z][Spasi]}
11. | Luas_Bangunan = | {[0-9][a-z][A-Z][Spasi]}
12. | Luas_Tanah = | {[0-9][a-Z][A-Z][Spasi]}
13. | Harga = | {[0-9][a-z][A-Z][Spasi]}
14. | DP_KPR = | {[0-9][a-Z][A-Z][Spasi]}
15. | Bank_KPR = | {[0-9][a-z][A-Z][Spasi]}
16. | Cicilan = | N[-+]?[0-9]*\.7[0-9]+$

Thumbnail = | @id + name + type + size + content

1. |Id = | {"[-+]?[0-9]}

2. | Name = | {[0-9][a-Z][A-Z][Spasi]}
3. | Type = | {[0-9][a-Z][A-Z][Spasi]}
4. | Size = | {"[-+]?[0-9]}

5. | Content = | {[0-9][a-Z][A-Z][Spasi]}

user = | @Id_User + Username + Password + Nama

1. | Id User = | {"[-+]?[0-9]}

2. | Username = | {[0-9][a-z][A-Z][Spasi]}
3. | Password = | {[0-9][a-Z][A-Z][Spasi]}
4. | Nama = | {[0-9][a-Z][A-Z][Spasi]}

111.3.2.3.2. Desain Tabel

Setelah melakukan tahap normalisasi, maka tahap selanjutnya yang dikerjakan

yaitu merancang struktur tabel pada basis data sistem yang akan dibuat, berikut ini

merupakan rancangan struktur tabel tersebut:

1. Struktur Tabel Gambar

Tabel gambar digunakan untuk menyimpan data id, name, type, size, content,

selengkapnya mengenai struktur tabel ini dapat dilihat pada tabel 111.2 berikut:
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Nama Database : hani_residence

Nama Tabel : gambar

Tabel 111.2 Rancangan Tabel Gambar

No Nama Field Tipe Data Boleh Kosong Kunci
1. |Id int(11) Tidak Primary Key
2. | Name Text Tidak -

3. | Type varchar(30) Tidak -

4. | Size int(11) Tidak -

5. | Content longblob Tidak -

2. Struktur Tabel Jalan

Tabel jalan digunakan untuk menyimpan data Kode Jalan, Nama_Jalan,
Tipe_Jalan, Lon, Lat, selengkapnya mengenai struktur tabel ini dapat dilihat pada

tabel 111.3 berikut;

Nama Database : hani_residence

Nama Tabel : jalan

Tabel 111.3 Rancangan Tabel Jalan

No Nama Field Tipe Data Boleh Kosong Kunci
1. | Kode_Jalan int(5) Tidak Primary Key
2. | Nama_Jalan varchar(30) Tidak -

3. | Tipe_Jalan varchar(10) Tidak -

4. | Lon Double Tidak -

5 | Lat Double Tidak -

3. Struktur Tabel Komentar
Tabel komentar digunakan untuk menyimpan data Kode Komentar, Nama,
Email, Tanggal, Pesan, selengkapnya mengenai struktur tabel ini dapat dilihat

pada tabel I11.4 berikut:

Nama Database - hani_residence

Nama Tabel : komentar
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Tabel 111.4 Rancangan Tabel Komentar

No Nama Field Tipe Data Boleh Kosong Kunci
1. | Kode_Komentar int(5) Tidak Primary Key
2. | Nama varchar(25) Tidak -

3. | Email varchar(25) Tidak -

4. | Tanggal datetime Tidak -

5. | Pesan Text Tidak -

4. Struktur Tabel Konten

Tabel konten digunakan untuk menyimpan data Kode_ Konten, Tanggal,
Terbit, Judul, Isi, Thumbnail, Tag, selengkapnya mengenai struktur tabel ini dapat

dilihat pada tabel 111.5 berikut:

Nama Database : hani_residence

Nama Tabel : konten

Tabel 111.5 Rancangan Tabel Konten

No Nama Field Tipe Data Boleh Kosong Kunci
1. | Kode_Konten int(11) Tidak Primary Key
2. | Tanggal timestamp Tidak -

3. | Terbit varchar(6) Tidak -

4. | Judul Text Tidak -

5. | Isi Text Tidak -

6. | Thumbnail int(11) Tidak Foreign Key
7. | Tag varchar(30) Tidak -

5. Struktur Tabel Residence
Tabel pangkalan digunakan untuk menyimpan data Kode Tempat,
Nama_Pangkalan, Alamat, Telepon, Gambar, Lon, Lat, Keterangan, selengkapnya

mengenai struktur tabel ini dapat dilihat pada tabel 111.6 berikut:

Nama Database : hani_residence

Nama Tabel : residence
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No Nama Field Tipe Data Boleh Kosong Kunci
1. | Kode_Tempat Int(5) Tidak Primary Key
2. | Nama_Residence varchar(25) Tidak -

3. | Alamat Text Tidak -

4. | Telepon varchar(12) Tidak -

5. | Gambar Int(11) Tidak Foreign Key
6. | Lon double Tidak -

7. | Lat double Tidak -

8. | Keterangan Text Tidak -

6. Struktur Tabel Spesifikasi

Tabel spesifikasi digunakan untuk menyimpan data Kode_Residence, Pondasi,

Dinding, Lantai, Plafond, Rangka Atap, Penutup_Atap, Kusen_Pintu_Jendela,

Air, Listrik, Luas_Bangunan, Luas_Tanah, Harga, DP_KPR, Bank_ KPR, Cicilan,

selengkapnya mengenai struktur tabel ini dapat dilihat pada tabel 111.7 berikut:

Nama Database

: hani_residence

Nama Tabel : spesifikasi
Tabel II1.7 Rancangan Tabel Spesifikasi

No Nama Field Tipe Data | Boleh Kosong Kunci
1. | Kode Residence int(11) Tidak Primary Key
2. | Pondasi text Tidak -

3. | Dinding text Tidak -

4. | Lantai text Tidak -

5. | Plafond text Tidak -

6. | Rangka Atap text Tidak -

7. | Penutup_Atap text Tidak -

8. | Kusen_Pintu_Jendela text Tidak -

9. | Air text Tidak -

10. | Listrik text Tidak -

11. | Luas_Bangunan text Tidak -

12. | Luas_Tanah text Tidak -

13. | Harga int(11) Tidak -

14. | DP_KPR int(11) Tidak -

15. | Bank_KPR text Tidak -

16. | Cicilan text Tidak -
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7. Struktur Tabel Thumbnail
Tabel thumbnail digunakan untuk menyimpan data id, name, type, size,
content, selengkapnya mengenai struktur tabel ini dapat dilihat pada tabel 111.8

berikut:

Nama Database : hani_residence

Nama Tabel : thumbnail

Tabel 111.8 Rancangan Tabel Thumbnail

No Nama Field Tipe Data Boleh Kosong Kunci
1. |Id int(11) Tidak Primary Key
2. | Name Text Tidak -

3. | Type varchar(30) Tidak -

4. | Size int(11) Tidak -

5. | Content Longblob Tidak -

8. Struktur Tabel User
Tabel user digunakan untuk menyimpan data Id_User, Username, Password,
Nama, selengkapnya mengenai struktur tabel ini dapat dilihat pada tabel 111.9

berikut:

Nama Database : hani_residence

Nama Tabel :user

Tabel 111.9 Rancangan Tabel User

Nama Database hani_residence

Nama Tabel User

No Nama Field Tipe Data Boleh Kosong Kunci
1. | Id_User int(11) Tidak Primary Key
2. | Username varchar(12) Tidak Unique
3. | Password varchar(12) Tidak -

4. | Nama varchar(25) Tidak -
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111.3.2.3.2. ERD (Entity Relationship Diagram)
Tahap selanjutnya pada penelitian ini yaitu merancang ERD untuk

mengetahui hubungan antar tabel yang telah didesain sebelumnya, ERD tersebut

dapat dilihat pada gambar 111.27 :
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Gambar 111.27 Diagram ERD



